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A Beginner’s Guide to TacOps



TacOpsCav 4.0
The Decision Making Simulation

Fight
More,
Talk Less!
  Using Tactical Simulations to
  Provide Experienced Leaders

GAUNTLET US ARMY



Introduction

Purpose
Familiarize students with TacOpsCav and demonstrate how it can be used as a
tool to provide experience-based learning both in the Institutional environment
and in the force.

Endstate
Each student has completed the Basic Training Scenario, fought

another student head to head, and seen how to use TacOpsCav as a training tool.
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Introduction

•Change in our teaching methodology
•External and internal assessments
•The missing link - experience

Why Simulations?
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Introduction

Why TacOpsCav? Purchased by the U.S. Army in 2000
Means for teaching rapid decision-making
Means for teaching how to develop tactical plans and write
operations orders
Means to emotionally involve leaders in the execution of their plan
in a battle competition
Runs on any standard laptop
Intuitive commands - doesn’t require an investment in operator
training
Comes with maps of widely varied terrain
Easy to build additional scenarios and modify old ones
Computer opponent allows individual practice
Reduces training constraints
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Installation

Minimum System Requirements
[Windows] Microsoft Windows 95 or newer.  
§  10 MB of memory remaining for TacOps 
§    after your Operating System has loaded  
§    (15 – 20 MB is recommended.)  
§  A hard disk drive  
§  Color monitor providing at least 256 colors or 
§    shades of gray. 

[Macintosh]  Apple Corporation System 
§Software Version 8.0 or greater.  
§  A hard disk drive.  
§  Color or grayscale monitor set for at least 
§    256 colors or shades of gray.  
§ 10 MB of memory available for allocation to 
§    the program (15-20 MB is recommended.) 



TacOps Files

Tacops.exe = Game system
*.sce = Standard scenario files (eg. Task Force Glascock.sce)
*.map = terrain data file (eg. Map001.map)
*.tac = Saved games

Autosave.tac
AutoSavexxx.tac (eg. AutoSave001.tac)
**********.tac

netfile.blu OR ordfile.red = net play
Play by E-mail

BTxxx.bmo & RTxxx.rmo & BTxxx_YYMMDD_HHMM



Startup Screen
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Initial Setup

Units which start the game 
already on the map will appear 
in a window titled "Setup On map 
Units".
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Map and Unit Symbols

To view a miniature version of the entire battle map, 
select the Map/Show Situation Map menu item. Use 
the usual window closing procedures or click within the 
situation map to close the window and return to the 
regular map.  Clicking inside the map area of the 
situation window will not only return to the regular map, 
it will also scroll and center the regular map to the same 
relative click point. Some maps may not have a miniature 
situation map display. 
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Terrain Symbols
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Checking Line of Sight
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Unit Symbols
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Giving Orders to Units

Unit Orders Window

GAUNTLETL US ARMY



Delayed Unit Orders Control

The buttons in the "Delayed Orders Controls" box
in the Unit Orders Window give orders that will 
not be executed until the next combat phase.

The “Seek Cover” button in the unit orders window does not
order a unit to enter an entrenchment unless the center point
of the unit marker is already over an entrenchment map
symbol.
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Instant Unit Orders Control

The Fire Control box shows and adjusts 
a unit's current engagement range limit 
between zero meters and the maximum 
useful range of its longest reaching weapon. 

The Orders box shows and adjusts the delayed
orders status of a unit - its unexecuted 
movement orders, facing changes, mode 
changes, and the like. 
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Unit SOP Window
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Supply Unit Button
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Unit Information Window
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Unit Information Window
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Movement

Units move according to their orders
Movement speed is affected by terrain and the suppressive

      effect of enemy fire
Movement is fastest on a road, less in clear terrain, much less in

     rough terrain, and slowest in woods
All units have the same opportunity to move, simultataneously,

      in one scale-second increments
Only aircraft and fully amphibious vehicles may move across

      water.
Infantry units on foot are not considered amphibious for

      game purposes.
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Controlling Direct Fires

You can set priority targets and a 
priority area of fire for a unit by 
using the buttons labeled 
Unit, Type, and DF TRP. 
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Indirect Fires

High trajectory fire delivered at a target which may or may not be
visible to the firer.
Only artillery or mortar units may use indirect fire.
Indirect fire attacks every unit within its burst radius.
If a unit symbol in the impact area represents three vehicles or
three squads, then every subunit will be attacked.
Target selection and firing for indirect fire is not automatic.
You must plot indirect fires during the orders phase using either
the Off Map Artillery Support Window or an on map unit’s
indirect fire controls.
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Off Map Artillery Support Window

The first number shows the accumulated 
accuracy of the mission. The second number 
indicates the minutes or seconds until the 
impact of the first or next volley. US ARMYGAUNTLET



On Map Artillery Support Window

Unit Orders Window
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Air Support Window

Each listing describes an air mission's current status. 
If an air support mission is underway the status line 
will state that the mission is enroute and will give the 
minutes until arrival at the target. If an air support 
mission is available but is not currently tasked, the 
status line will show how long it will take the aircraft 
to arrive if called. 
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Game Options and Preferences
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Network Play
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Two-Player Network Game

Open Game
Select Two Player Network
Select Color/Team then Host or Join
Game
Select Scenario
Set up forces / save the game [re-name it]
Log onto Network
Determine with opponent a fighting SOP, i.e..

      Order for 2 min, fight one game turn etc.
Fight!!!!GAUNTLET US ARMY



Two-Player Network Game

Open Game
Select Two Player Network
Select Color/Team then Host or Join Game
Select Scenario
Set up forces / save the game [re-name it]
Log onto Network
Determine with opponent a fighting SOP, i.e..

      Order for 2 min, fight one game turn etc.
Fight!!!!
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Open Game
Select Two Player Network
Select Color/Team then Host or Join Game
Select Scenario
Set up forces / save the game [re-name it]
Log onto Network
Determine with opponent a fighting SOP, i.e..

      Order for 2 min, fight one game turn etc.
Fight!!!!

Two-Player Network Game
Log onto the network and find the computer to host 
the Game. This version is run across the network 
[LAN] but the hosting computer is in control.
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Two-Player Network Game

To join the game in 2 player or Multiplayer you need the 
IP Address of the Computer that is hosting the Game/fight.

Host IP
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Multi--Player Network Game

Open Game
Select Multi- Player Network
Select Join Game then Color/Team
Select Scenario
Set up forces / save the game [re-name it]
Log onto Network
Determine with opponent a fighting SOP, i.e..

      Order for 2 min, fight one game turn etc.
Fight!!!!GAUNTLET US ARMY



Multi--Player Network Game

Open Game
Select Multi- Player Network
Select Join Game then Color/Team
Select Scenario
Set up forces / save the game [re-name it]
Log onto Network
Determine with opponent a fighting SOP, i.e..

      Order for 2 min, fight one game turn etc.
Fight!!!!GAUNTLET US ARMY

To join the game in 2 player or Multiplayer you 
need the IP Address of the Computer that is 
hosting the Game/fight.



Network Chat

You may send text messages 
to the enemy commander by 
selecting the Network/Send 
A Message menu item. 
Avoid sending messages while 
the computers are exchanging 
orders. Sometimes your opponent 
may be doing something that is 
incompatible with receiving chat 
messages. If so you may not get 
an immediate response to a 
message but the message will be 
delivered as soon as the enemy 
commander starts a different activity.
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Play By Mail

v
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Open Game
Select Two Players-Play by Mail
Select  color of force you will command
Select a Scenario or Saved Game
Set up forces / save the game [re-name it]
Issue orders, then select File/PBM Send
Orders
Use File/PBM Receive Orders to load
opponent’s orders
Determine with opponent a fighting SOP, i.e..

      Order for 2 min, fight one game turn etc.
Fight!!!!



Play By Modem

v

Open Game
Select Two Players-Play by Mail
Select  color of force you will command
Select a Scenario or Saved Game
Set up forces / save the game [re-name it]
Issue orders, then select File/PBM Send
Orders
Use File/PBM Receive Orders to load
opponent’s orders
Determine with opponent a fighting SOP, i.e..

      Order for 2 min, fight one game turn etc.
Fight!!!!GAUNTLET US ARMY



The File Menu

US ARMYGAUNTLET



The Combat Menu
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The Orders Menu
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The Orders Menu
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The Reports Menu
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The Network Menu
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The Options Menu
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The Help Menu

Guide - User 
 
Summons an online help file.
 
Guide – Scenarios
 
Summons an online help file containing 
a text description of the situation, the order 
of battle, and the victory objectives for most 
TacOps scenarios.
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Engineering Tools



Open Game
Select Multi-Player Network
Select Host
Select Scenario to alter or select Custom US Scenario
Select Orders to complete/color etc
Emplace forces, Arty, Air, obstacles, etc
Assign PINs for all forces [Host must be 0]
Set Fog of War, ROE, and save the game
Log onto network and wait for players to join

Building a Scenario as a Host
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Building a Scenario as a Host

Open Game
Select Multi-Player Network
Select Host
Select Scenario to alter or select Custom
US Scenario and Map
Select Orders to complete/color etc
Emplace forces, Arty, Air, obstacles, etc
Assign PINs for all forces [Host must be 0]
Set Fog of War, ROE, and save the game
Log onto network and wait for players to join US ARMYGAUNTLET



Building a Scenario as a Host

Open Game
Select Multi-Player Network
Select Host
Select Scenario to alter or select Custom US
Scenario and Map
Select Orders to complete/color etc
Emplace forces, Arty, Air, obstacles, etc
Assign PINs for all forces [Host must be 0]
Set Fog of War, ROE, and save the game
Log onto network and wait for players to join

US ARMYGAUNTLET



Open Game
Select Multi-Player Network
Select Host
Select Scenario to alter or select Custom US
Scenario and Map
Select Orders to complete/color etc
Emplace forces, Arty, Air, obstacles, etc
Assign PINs for all forces [Host must be 0]
Set Fog of War, ROE, and save the game
Log onto network and wait for players to join

Building a Scenario as a Host
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PIN 3

PIN 2

PIN 1

PIN 7

PIN 8

PIN 9

6 players, two teams BLUFOR Player Identification Number 
[PIN] 1-3  vs OPFOR PINs 7-9.  There are 6 other force colors to use. 

Building a Scenario as a Host



Building a Scenario as a Host

Open Game
Select Multi-Player Network
Select Host
Select Scenario to alter or select Custom
US Scenario and Map
Select Orders to complete/color etc
Emplace forces, Arty, Air, obstacles, etc
Assign PINs for all forces [Host must be 0]
Set Fog of War, ROE, and save the
game
Log onto network and wait for players to
join
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If checked, other like forces
can only observe each other
if in LOS. 

A very powerful tool that is 
comparable to FBCB2 capability.
You can control situational 
awareness from here.



Open Game
Select Multi-Player Network
Select Host
Select Scenario to alter or select Custom
US Scenario and Map
Select Orders to complete/color etc
Emplace forces, Arty, Air, obstacles, etc
Assign PINs for all forces [Host must be 0]
Set Fog of War, ROE, and save the
game
Log onto network and wait for players to
join

Building a Scenario as a Host



Open Game
Select Multi-Player Network
Select Host
Select Scenario to alter or select Custom
US Scenario and Map
Select Orders to complete/color etc
Emplace forces, Arty, Air, obstacles, etc
Assign PINs for all forces [Host must be 0]
Set Fog of War, ROE, and save the game
Log onto network and wait for players
to join

Building a Scenario as a Host
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The Host starts combat phases and hosts all play.
The Host always has perfect situational awareness 
in multiplayer mode.
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Building a Scenario as a Host



Logistics
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Time executed in 15 sec intervals
Movement, spotting, firing, damage

Rough affects speed/spotting
Hit and Damage Assessment

H- hit or near miss
S- suppressed
Skull- individual casualties
D- mobility or firepower kill
Explosion- one or more vehicle kills
E- unit totally eliminated

General Notes
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Questions?
If not, let’s FIGHT!
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